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 Introduction Who Should Read This Book This book is for anyone comfortable using a personal computer who needs to collect and manipulate information. Experience with Microsoft Access 2010 or an earlier version of Access is helpful, but not necessary. The book takes the user from the basic techniques on how to use Microsoft Access 2010 to a strong intermediate level. After reading this book, you should be comfortable creating and working with databases and the objects that they contain.
 
 How This Book Is Organized This book starts by covering the basics of working with Microsoft Access. You learn the basics of working with databases, tables, queries, forms, and reports. After learning the basics, you are ready to move to more advanced features, where you learn how to build your own databases and tables and how to relate the tables within your database. You are then ready to embark on a journey through power query, form, and report techniques. Finally, you learn about three exciting aspects of Access 2010. You learn how to create macros, how to share data with other applications, and how to build a database that runs in a browser.
 
 Requirements, Editions, and Features Microsoft hasn’t dramatically increased the hardware requirements for Access 2010 compared to those for earlier versions of Access. In fact, if anything, you’ll find Access 2010 runs on existing hardware as well as or even better than earlier versions of Access. To be sure you can run Access 2010, here’s a look at the basic hardware and operating system requirements: • 500MHz or faster 32-bit or 64-bit processor • 256MB of RAM • 2GB available hard disk space (32-bit) or 20GB (64-bit) • 1024x768 resolution monitor • Windows XP with Service Pack 3, Windows Vista with SP1, Windows Server 2003 R2 with MXXML 6.0, Windows Server 2008 (32-bit or 64-bit), Windows 7, or later operating systems
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 Let’s take a peek at some of the techniques for using Access 2010 that you’ll be learning about: • Manipulating data—After you learn about relational databases, and what Microsoft Access 2010 has to offer, Chapter 1, “Manipulating Data with Databases and Tables,” shows you how to open a database and modify the data within it. You will also learn how to filter table data. • Retrieving the data you need—Chapter 2, “Using Queries to Retrieve the Data You Need,” shows you all the basics of working with queries. You learn techniques such as how to select fields, apply criteria, and order the query result. • Displaying data with forms—Chapter 3, “Using Forms to Enter and Edit Table Data,” shows you how to manipulate table data from within a form. It also covers the process of using a Form Wizard to create a form. • Printing data with reports—Chapter 4, “Using Reports to Print Information,” first shows you how to open, view, and print an existing report. You then learn how to build your own reports. • Building databases and tables—Chapter 5, “Creating Your Own Databases and Tables,” covers both the process of creating new databases, and of creating new tables. In this chapter, you learn important techniques such as how to work with field properties. • Relating the data in your database—Chapter 6, “Relating the Information in Your Database,” shows you how to relate the tables that you build. After this chapter provides you with a crash course on database design, you learn how to establish relationships, and how to enforce referential integrity. • Working with queries—Chapter 7, “Enhancing the Queries That You Build,” enhances what you learned about queries in Chapter 2. In this chapter, you learn how to build queries based on multiple tables, how to add calculations to the queries that you build, how to run parameter queries when you don’t know the criteria at design time, how to use action queries to update your table data, and how and why to work with outer joins. • Working with forms—Chapter 8, “Building Powerful Forms,” enhances what you learned about forms in Chapter 3. In this chapter, you learn how to work with form controls, how to apply conditional formatting, and how to modify form properties. You also learn how to work with combo boxes, the Command Button Wizard, how to build forms based on more than one table, and how to work with subforms. • Working with reports—Chapter 9, “Building Powerful Reports,” enhances what you learned about reports in Chapter 4. In this chapter you learn how to
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 work with report bands, work with controls, build multi-table reports, work with subreports, add sorting and grouping, and take advantage of report properties. • Using macros to automate your database—Chapter 10, “Automating Your Database with Macros,” shows you how to automate the databases that you build. In this chapter, you learn important techniques such as how to create and run macros, how to control the flow of the macros that you build, and how to create submacros. You also learn how to take advantage of Access 2010’s new features such as embedded macros, data macros, and drillthrough macros. You learn how to work with variables and error handling, and finally, you learn how to take advantage of a very special macro, the AutoExec macro. • Sharing data with other applications—One of Access’s greatest strengths is its ability to share data with other applications. In Chapter 11, “Sharing Data with Other Applications,” you learn how to export data to and import data from Excel, text files, and other Access databases. You learn how to link to data in other databases, and how to use a powerful tool called the Linked Table Manager to manage the links that you create. As a special bonus, you learn how to link to data in a SQL Server database, so that you can take advantage of Access’s strong ability to participate in a client/server environment. • Running your application in a web browser—Chapter 12, “Working with Web Databases,” shows you how to take your database to the Web. In this chapter, you learn about web databases and what they are. You are introduced to application parts, and you learn how to create server objects. Finally, you witness your completed application running in a web browser. Whether it’s the new and exciting macro environment, or the ability to easily take Access data to the Web, it won’t take long for you to get to know this new and exciting version of Microsoft Access. Access 2010 is fast, stable, and extremely packed with new and thrilling features. Using Access 2010 is your personal guide to learning how to use Access 2010 and how to get the most out of what it has to offer.
 
 Using This Book This book allows you to customize your own learning experience. The step-by-step instructions in the book give you a solid foundation in using Access 2010, while rich and varied online content, including video tutorials and audio sidebars, provide the following:
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 • Demonstrations of step-by-step tasks covered in the book • Additional tips or information on a topic • Practical advice and suggestions • Direction for more advanced tasks not covered in the book Here’s a quick look at a few structural features designed to help you get the most out of this book. • Chapter objective: At the beginning of each chapter is a brief summary of topics addressed in that chapter. This objective enables you to quickly see what is covered in the chapter. • Notes: Notes provide additional commentary or explanation that doesn’t fit neatly into the surrounding text. Notes give detailed explanations of how something works, alternative ways of performing a task, and other tidbits to get you on your way.
 
 LET ME TRY IT tasks are presented in a step-by-step sequence so you can easily follow along.
 
 SHOW ME video walks through tasks you’ve just got to see—including bonus advanced techniques.
 
 TELL ME MORE audio delivers practical insights straight from the experts.
 
 Special Features More than just a book, your USING product integrates step-by-step video tutorials and valuable audio sidebars delivered through the Free Web Edition that comes with every USING book. For the price of the book, you get online access anywhere with a web connection—no books to carry, content is updated as the technology changes, and the benefit of video and audio learning.
 
 About the USING Web Edition The Web Edition of every USING book is powered by Safari Books Online, allowing you to access the video tutorials and valuable audio sidebars. Plus, you can search the contents of the book, highlight text and attach a note to that text, print your notes and highlights in a custom summary, and cut and paste directly from Safari Books Online. To register this product and gain access to the Free Web Edition and the audio and video files, go to quepublishing.com/using.
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 Using Access 2010, you use databases and tables to manipulate data.
 
 1
 
 Manipulating Data with Databases and Tables In this chapter, you will learn what a relational database is. You will then discover some of the exciting things you can do with Microsoft Access. With that information under your belt, you will begin working with existing Access databases. You will learn both how to navigate the data in a table and how to edit the data that you are viewing. Finally, you’ll learn how to search for specific data that you want to work with.
 
 What Is a Relational Database? The term database means different things to different people. For many years, in the world of xBase (that is, dBASE, FoxPro, CA-Clipper, and other older database technologies), database was used to describe a collection of fields and records. (Access refers to this type of collection as a table.) In a client/server environment, database refers to all the data, schema, indexes, rules, triggers, and stored procedures associated with a system. In Access terms, a database is a collection of all the tables, queries, forms, reports, macros, and modules that compose a complete system. Relational refers to concepts based on set theory. These concepts are covered in Chapter 6, “Relating the Information in Your Database.”
 
 A Preview of the Database Components As mentioned previously, tables, queries, forms, reports, macros, and modules combine to comprise an Access database. Each of these objects has a special function. The following sections take you on a tour of the objects that make up an Access database.
 
 Tables: A Repository for Data Tables are the starting point for an application. Whether data is stored in an Access database or you are referencing external data by using linked tables, all the other objects in a database either directly or indirectly reference tables.
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 Chapter 1
 
 |
 
 M a n i p u l a t i n g D a t a w i t h D a t a b a s e s a n d Ta b l e s
 
 To view all the tables that are contained in an open database, you select Tables from the list of objects available in the database (see Figure 1.1). A list of available tables appears (see Figure 1.2).
 
 Figure 1.1 To view the tables in a database, select Tables from the list of available objects.
 
 To view the data in a table, double-click the name of the table you want to view. (You can also right-click the table and then select Open.) Access displays the table’s data in a datasheet that includes all the table’s fields and records (see Figure 1.3). You can modify many of the datasheet’s attributes and even search for and filter data from within the datasheet; these techniques are covered later in this chapter. If the table is related to another table (such as the Northwind database’s Customers and Orders tables), you can also expand and collapse the sub-datasheet to view data stored in child tables (see Figure 1.4). As an Access user, you will often want to view the table’s design, which is the blueprint or template for the table. To view a table’s design (see Figure 1.5), right-click the table name in the Navigation Pane, and then select Design View. In Design view, you can view or modify all the field names, data types, and field and table properties. Access gives you the power and flexibility you need to customize the design of tables. Chapter 5, “Creating Your Own Databases and Tables,” covers these topics.
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 Figure 1.2 You can view the tables contained in a database.
 
 Figure 1.3 A table’s datasheet contains fields and records.
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 Figure 1.4 Datasheet view of the Customers table in the Northwind database.
 
 Figure 1.5 The design of the Customers table.
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 Relationships: Tying the Tables Together To properly maintain data’s integrity and ease the process of working with other objects in a database, you must define relationships among the tables in a database. You accomplish this by using the Relationships window. To view the Relationships window, select Relationships from the Database Tools tab of the Ribbon. The Relationships window appears. In this window, you can view and maintain the relationships in the database (see Figure 1.6). If you or a fellow user or developer have set up some relationships, but you don’t see any in the Relationships window, you can select All Relationships in the Relationships group on the Design tab of the Ribbon to unhide any hidden tables and relationships.
 
 Figure 1.6 The Relationships tab, where you view and maintain the relationships in a database.
 
 Notice that many of the relationships in Figure 1.6 have join lines between tables and show a number 1 on one side of the join and an infinity symbol on the other. This indicates a one-to-many relationship between the tables. If you double-click a join line, the Edit Relationships dialog box opens (see Figure 1.7). In this dialog box, you can specify the exact nature of the relationship between tables. The relationship between the Customers and Orders tables in Figure 1.7, for example, is a oneto-many relationship with referential integrity enforced. This means that the user cannot add orders for customers who don’t exist. Notice in Figure 1.7 that the
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 Cascade Update Related Fields check box is selected. This means that if the user updates a CustomerID field, Access updates all records containing that CustomerID value in the Orders table. Because Cascade Delete Related Records is not checked in Figure 1.7, the user cannot delete from the Customers table customers who have corresponding orders in the Orders table.
 
 Figure 1.7 The Edit Relationships dialog box, which lets you specify the nature of the relationships between tables.
 
 Chapter 6, “Relating the Information in Your Database,” extensively covers the process of defining and maintaining relationships. For now, you should remember that you should establish relationships both conceptually and literally as early in the design process as possible. Relationships are integral to successfully designing and implementing your application.
 
 Queries: Stored Questions or Actions You Apply to Data Queries in Access are powerful and multifaceted. A query retrieves data from your database based on criteria you specify. An example is a query that retrieves all employees who live in Florida. Select queries allow you to view, summarize, and perform calculations on the data in tables. Action queries let you add to, update, and delete table data. To run a query, you select Queries from the Objects list and then double-click the query you want to run, or you can click in the list of queries to select the query you want to run and then right-click and select Open. When you run a Select query, a datasheet appears, containing all the fields specified in the query and all the records meeting the query’s criteria (see Figure 1.8). When you run an Action query, Access runs the specified action, such as making a new table or appending data to an existing table. In general, you can update the data in a query result because the result of a query is actually a dynamic set of records,
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 called a dynaset, that is based on the tables’ data. A dynaset is a subset of data on which you can base a form or report.
 
 Figure 1.8 The result of running the Product Orders query.
 
 When you store a query, Access stores only the query’s definition, layout, or formatting properties in the database. Access offers an intuitive, user-friendly tool that helps you design queries: the Query Design window (see Figure 1.9). To open this window, select Queries from the Objects list in the Navigation Pane, choose the query you want to modify, right-click, and select Design View. The query pictured in Figure 1.9 selects data from the CustomersExtended query and the Orders and Order Details tables. It displays several fields, including the ProductID, Quantity, Unit Price, and Discount fields from the Order Details table, and the OrderID, Order Date, Shipped Date, and CustomerID fields from the Orders table. The query’s output displays the data in order by order date. It displays only records with order dates within a specific date range. This special type of query is called a parameter query. It prompts for criteria at runtime, using the criteria entered by the user to determine which records it includes in the output. Chapter 2, “Using Queries to Retrieve the Data You Need,” and Chapter 7, “Enhancing the Queries That You Build,” both cover the process of designing queries. Because queries are the foundation for most forms and reports, they are covered throughout this book as they apply to other objects in the database.
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 Figure 1.9 The design of a query that displays data from the Customer Extended query, Orders table, and Order Details table.
 
 Forms: A Means of Displaying, Modifying, and Adding Data Although you can enter and modify data in a table’s Datasheet view, you can’t control the user’s actions very well, nor can you do much to facilitate the data-entry process. This is where forms come in. Access forms can have many traits, and they’re very flexible and powerful. To view a form, you select Forms from the Objects list. Then you double-click the form you want to view or right-click in the list of forms to select the form you want to view and then click Open. Figure 1.10 illustrates a form in Form view. This Customer Details form is actually two forms in one: one main form and one subform. The main form displays information from the Customers table, and the subform displays information from the Orders table (a table that is related to the Customers table). As the user moves from customer to customer, the form displays the orders associated with that customer. When the user clicks to select an order, the form displays the entire order. Like tables and queries, you can also view forms in Design view. The Design view provides tools you may use to edit the layout of your form. To view the design of a
 
 A Pre v i e w o f t h e D a t a b a s e Co m p o n e n t s
 
 Figure 1.10 The Customer Details form, which includes customer, order, and order detail information.
 
 form, you select Forms from the Objects list, choose the form whose design you want to modify, and then right-click and select Design View. Figure 1.11 shows the Customer Details form in Design view. Chapter 3, “Using Forms to Enter and Edit Table Data,” and Chapter 8, “Building Powerful Forms,” cover forms in more detail.
 
 Reports: Turning Data into Information Forms allow you to enter and edit information, but with reports, you can display information, usually to a printer. Figure 1.12 shows a report in Preview mode. To preview any report, you select Reports from the Objects list. You double-click the report you want to preview or right-click the report you want to preview from the list of reports in the Navigation Pane, and then you click Open. Notice the chart in the report in Figure 1.12. Like forms, reports can be elaborate and exciting, and they can contain valuable information. As you may have guessed, you can view reports in Design view, as shown in Figure 1.13. To view the design of a report, you select Reports from the Objects list, select the report you want to view, and then right-click and select Design View. Figure 1.13 illustrates a report with many sections; in the figure you can see the Page Header, Order ID Header, Detail section, Order ID Footer, and Page Footer (just a
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 Figure 1.11 The design of the Customer Details form, showing two subforms.
 
 Figure 1.12 A preview of the Product Sales Quantity by Employee report.
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 few of the many sections available on a report). Just as a form can contain subforms, a report can contain subreports. Chapter 4, “Using Reports to Print Information,” and Chapter 9, “Building Powerful Reports,” cover the process of designing reports.
 
 Figure 1.13 Design view of the Invoice report.
 
 Macros: A Means of Automating a System Macros in Access aren’t like the macros in other Office products. You can’t record them, as you can in Microsoft Word or Excel, and Access does not save them as Visual Basic for Applications (VBA) code. With Access macros, you can perform most of the tasks that you can manually perform from the keyboard, Ribbon, and QuickAccess toolbar. Macros allow you to build logic in to your application flow. To run a macro, select Macros from the Objects list, and then double-click the macro you want to run (or you can right-click the macro and click Run). Access then executes the actions in the macro. To view a macro’s design, you select Macros from the Objects list, select the macro you want to modify, right-click and select Design View to open the Macro Design window (see Figure 1.14). The macro pictured in
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 Figure 1.14 performs one action, the MessageBox action. The MessageBox action accepts four arguments: Message, Beep, Type, and Title.
 
 Figure 1.14 The design of a macro containing the MessageBox action.
 
 Modules: The Foundation of the Application Development Process Modules, the foundation of any complex Access application, let you create libraries of functions that you can use throughout an application. You usually include subroutines and functions in the modules that you build. A function always returns a value; a subroutine does not. By using code modules, you can do just about anything with an Access application. Figure 1.15 shows an example of a module.
 
 What Types of Things Can I Do with Microsoft Access? I often find myself explaining exactly what types of applications you can build with Microsoft Access. Access offers a variety of features for different database needs. You can use it to develop five general types of applications: • Personal applications • Small-business applications
 
 Wh a t Ty p e s o f Th i n g s Ca n I D o w i t h M i c ro s o f t Acce s s ?
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 Figure 1.15 The global code module in Design view, showing the General Declarations section and the Generate and Create functions.
 
 • Departmental applications • Corporation-wide applications • Front-end applications for enterprise-wide client/server databases
 
 Access as a Development Platform for Personal Applications At a basic level, you can use Access to develop simple personal database-management systems. I know people who automate everything from their wine collections to their home finances. The one thing to be careful of is that Access is deceptively easy to use. Its wonderful built-in wizards make Access look like a product that anyone can use. After answering a series of questions, you have finished application switchboards that allow you to easily navigate around your application, data-entry screens, reports, and the underlying tables that support them. In fact, when Microsoft first released Access, many people asked whether I was concerned that my business as a computer programmer and trainer would diminish because Access seemed to let absolutely anyone write a database application. Although it’s true that you can produce the simplest of Access applications without any thought
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 for design and without any customization, most applications require at least some design and customization. If you’re an end user and don’t want to spend too much time learning the intricacies of Access, you’ll be satisfied with Access as long as you’re happy with a wizardgenerated personal application. After reading this text, you can make some modifications to what the wizards have generated, and no problems should occur. It’s when you want to substantially customize a personal application without the proper knowledge base that problems can happen.
 
 Access as a Development Platform for SmallBusiness Applications Access is an excellent platform for developing an application that can run a small business. Its wizards let you quickly and easily build the application’s foundation. The ability to create macros and to build code modules allows power users and developers to create code libraries of reusable functions, and the ability to add code behind forms and reports allows them to create powerful custom forms and reports. The main limitation of using Access for developing a custom small-business application is the time and money involved in the development process. Many people use Access wizards to begin the development process but find they need to customize their applications in ways they can’t accomplish on their own. Small-business owners often experience this problem on an even greater scale than personal users. The demands of a small-business application are usually much higher than those of a personal application. Many doctors, attorneys, and other professionals have called me in after they reached a dead end in the development process. They’re always dismayed at how much money it will cost to make their application usable. An example is a doctor who built a series of forms and reports to automate her office. All went well until it came time to produce patient billings, enter payments, and produce receivable reports. Although at first glance these processes seem simple, on further examination the doctor realized that the wizard-produced reports and forms did not provide the sophistication necessary for her billing process. Unfortunately, the doctor did not have the time or programming skills to add the necessary features. So, in using Access as a tool to develop small-business applications, it is important that you be realistic about the time and money involved in developing anything but the simplest of applications.
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 Access as a Development Platform for Departmental Applications Access is perfect for developing applications for departments in large corporations. Most departments in large corporations have the development budgets to produce well-designed applications. Fortunately, most departments also usually have a PC guru who is more than happy to help design forms and reports. This gives the department a sense of ownership because it has contributed to the development of its application. If complex form or report design or coding is necessary, large corporations usually have onsite resources available that can provide the necessary assistance. If the support is not available within the corporation, most corporations are willing to outsource to obtain the necessary expertise.
 
 Access as a Development Platform for Corporationwide Applications Although Access might be best suited for departmental applications, you can also use it to produce applications that you distribute throughout an organization. How successful this endeavor is depends on the corporation. There’s a limit to the number of users who can concurrently share an Access application while maintaining acceptable performance, and there’s also a limit to the number of records that each table can contain without a significant performance drop. These numbers vary depending on factors such as the following: • How much traffic already exists on the network. • How much RAM and how many processors the server has. • How the server is already being used. For example, are applications such as Microsoft Office being loaded from the server or from local workstations? • What types of tasks the users of the application are performing. For example, are they querying, entering data, running reports, and so on? • Where Access and Access applications are run from (the server or the workstation). • What network operating system is in place. My general rule of thumb for an Access application that’s not client/server based is that poor performance generally results with more than 10 to 15 concurrent users and more than 100,000 records. Remember that these numbers vary immensely
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 depending on the factors mentioned, and on what you and the other users of the application define as acceptable performance. If you go beyond these limits, you should consider using Access as a front end to a client/server database such as Microsoft SQL Server—that is, you can use Access to create forms and reports while storing tables and possibly queries on the database server.
 
 Access as a Front End for Enterprise-wide Client/Server Applications A client/server database, such as Microsoft SQL Server or Oracle, processes queries on the server machine and returns results to the workstation. The server software itself can’t display data to the user, so this is where Access comes to the rescue. Acting as a front end, Access can display the data retrieved from the database server in reports, datasheets, or forms. If the user updates the data in an Access form, the workstation sends the update to the back-end database. You can accomplish this process either by linking to these external databases so that they appear to both you and the user as Access tables or by using techniques to access client/server data directly.
 
 Working with an Existing Database Before we dive right into creating our own databases, we’re going to start by working with an existing database. To work with an existing database, you must first open it.
 
 LET ME TRY IT
 
 Open an Existing Database To open an existing database: 1. From File tab of the Ribbon (see Figure 1.16) select one of the recently opened databases, or click Open to view additional files. If you click Open, the Open dialog appears (see Figure 1.17). 2. Locate the file you want to open and then click Open. Access opens the file, and the desktop appears as in Figure 1.18.
 
 Your desktop might not look exactly like the figure. This is because Access remembers the state of the Navigation Pane when you last had the database open. For example, if you had the list of tables expanded the last time the database was
 
 Wo r k i n g w i t h a n E x i s t i n g D a t a b a s e
 
 Figure 1.16 The Opening Access screen.
 
 Figure 1.17 The Open dialog.
 
 open, Access will show the list of tables in the Navigation Pane the next time that you open the database. In fact, you can collapse the Navigation Pane entirely by using the Shutter Bar Open/Close Button at the top of the Navigation Pane.
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 Figure 1.18 The Access desktop.
 
 Working with Table Data Tables are the basis of everything that you do in Access. Most of the data for your database resides in tables. So if you’re creating an employee payroll database, your employee data will be stored in a table, your payroll codes might be stored in a table, and your past payroll records could be stored in a table. A table contains data about a specific topic or subject (for example, customers, orders, or employees). Tables are arranged in rows and columns, similar to a spreadsheet. The columns represent the fields, and the rows represent the records (see Figure 1.19).
 
 Open an Access Table In working with tables, the first thing you’ll want to be able to do is open them in Datasheet view and navigate around them. The text that follows covers all the basics of working with tables in Datasheet view. To open a table in Datasheet view, follow these steps: 1. Select Tables in the list of objects in the Navigation Pane. 2. Select the table you want to open and click the Open button in the Navigation Pane or double-click the table you want to open.
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 Figure 1.19 A table composed of columns and rows associated with customers.
 
 Navigating Around a Table You can move around a table by using the keyboard or mouse. When you are editing or adding records, your hands are on the keyboard, and you might find it easiest to move around a table by using the keyboard. However, if you are looking for a specific record, you might find it most convenient to use the mouse. Table 1.1 shows the keyboard and mouse actions for moving around a table and their resulting effects. As you can see, Microsoft Access provides numerous keyboard and mouse alternatives for moving around a table. The insertion point does not change locations just because you move your mouse, only the mouse pointer moves when you move your mouse. You need to click within a field before you begin typing; otherwise, the changes occur in the original mouse location. The tab displaying the data includes tools that enable you to scroll through the fields and records, move from record to record, expand and collapse to show and hide related records, and more. Figure 1.20 illustrates these features. Table 1.2 provides a list of these features and provides a description of each.
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 Table 1.1 Keyboard and Mouse Actions to Move Around a Table Keyboard Action
 
 Mouse Action
 
 Effect
 
 Tab or right arrow
 
 Click the right arrow on the bottom scrollbar.
 
 Moves one field to the right of the current field
 
 Shift+Tab or left arrow Click the left arrow on the bottom scrollbar.
 
 Moves one field to the left of the current field
 
 Down arrow
 
 Click the next record button.
 
 Moves down one record
 
 Up arrow
 
 Click the previous record button.
 
 Moves up one record
 
 Page Down
 
 No equivalent mouse action
 
 Moves down one screen of records
 
 Page Up
 
 No equivalent mouse action
 
 Moves up one screen of records
 
 Home
 
 No equivalent mouse action
 
 Selects the first field of the current record
 
 End
 
 No equivalent mouse action
 
 Selects the last field of the current record
 
 Ctrl+Home
 
 Click the first record button.
 
 Moves to the first record of the table
 
 Ctrl+End
 
 Click the last record button.
 
 Moves to the last record of the table
 
 F2
 
 Click and drag within a field.
 
 Selects the text in the field
 
 Table tab
 
 Expand indicator Navigation buttons
 
 Figure 1.20 The Table window.
 
 Scrollbar
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 Table 1.2 The Components of the Table Window Table Component
 
 Description
 
 Table tab
 
 Allows you to easily select the open table.
 
 Scrollbar
 
 You can use the scrollbars to move up and down and right and left in the table.
 
 Navigation buttons
 
 These icons enable you to select the first record, last record, next record, or previous record in the table.
 
 Expand indicator
 
 The expand indicator enables you to view the data hierarchy by showing you any subdata records that are linked to the main record.
 
 SHOW ME
 
 Media 1.1—Viewing and Navigating Table Data Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Closing a Table When you are finished working with a table, you need to close it. To close a table, you choose File, Close or click the close button in the upper-right corner of the Table tab. Access often prompts you as you close a table, asking if you want to save changes to the layout of the table. It is important that you understand that Access is not asking whether you want to save changes to the data. As you’ll learn in a moment, Access saves changes to data the moment you move off a record. When you close a table and Access prompts you, it is asking whether you want to save formatting changes, such as changes to column width, to the look of the datasheet, and so on.
 
 Editing Table Data You can change the data in a table any time that you are in Datasheet view of a table, the result of a query, or Form view of a form. Access saves changes you make to a record as soon as you move off the record.
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 LET ME TRY IT
 
 Edit Existing Records One task you might want to perform is to simply modify table data. Here’s the process: 1. Select the record you want to change by using any of the techniques listed in Table 1.2. 2. Select the field you want to change by clicking the field or using the arrow keys. 3. Type to make the necessary changes to the data. Once you move off the record, Access saves your changes.
 
 Undoing Changes There are different options available when undoing changes to a field or to a record. The options differ depending on whether you are still within a field, have left the field, or have left the record. The sections that follow explore the various options available to you.
 
 Undoing Changes Made to the Current Field When you are in the process of making changes to a field, you might realize that you really didn’t want to make changes to that field or to that record. To undo changes to the current field, you can either click the Undo tool on the QuickAccess toolbar or press the Esc key once. For example, if you mean to change the contact first name from Alison to Sue, but realize that you are accidentally typing Sue in the Customer field, you can press the Esc key once, or click the Undo tool on the QuickAccess toolbar, to undo your change.
 
 Undoing Changes After You Move to Another Field The process of undoing changes after you move to another field is identical to that of the process of undoing changes made to the current field. You can either click the Undo tool on the QuickAccess toolbar or press the Esc key once. For example, if you mean to change the contact first name from Alison to Sue, but realize that you accidentally typed Sue in the Customer field, and then moved to another field, you could click the Undo tool on the QuickAccess toolbar, or press the Esc key once, to undo your change.
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 Undoing Changes After You Save a Record When you make changes to a field and then move to another record, Access saves all changes to the modified record. So long as you do not begin making changes to another record, you can still undo the changes you made to the most recently modified record. To do this, you can either click the Undo tool on the QuickAccess toolbar or press the Esc key twice. For example, if you mean to change the contact first name from Alison to Sue, but realize that you accidentally typed Sue in the Customer field, and then moved to another record, you either click the Undo tool on the QuickAccess toolbar or press the Esc key twice to undo your change.
 
 SHOW ME
 
 Media 1.2—Editing Existing Records Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 If Access is unable to undo a change, the Undo tool appears dimmed.
 
 After you have made changes to a record and then have gone on to make changes to another record, you cannot undo the changes that you made to the first record.
 
 Adding Records to a Table Access adds records to the end of a table, regardless of how you add them to the table.
 
 LET ME TRY IT
 
 Add Records to a Table To add records, follow these steps: 1. Select the table to which you want to add information. 2. Click the New Record Navigation button at the bottom of the Datasheet window. 3. Add the necessary information to the fields within the record. When you move off the record, Access saves the new record.
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 You can use Ctrl + “ to repeat the data in the field directly above the current field. It is also important to note that Access always displays one blank record at the end of a table. When entering data, pressing the Tab key at the end of a record that you just added allows you to continue to add additional records.
 
 SHOW ME
 
 Media 1.3—Adding Records to a Table Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Deleting Records Before you can delete records, you must select them. The following sections cover the process of selecting records and then the process of deleting records.
 
 Selecting One or More Records To select one record, you just click the gray record selector button to the left of the record within the datasheet. To select multiple records, you click and drag within the record selector area. Access selects the contiguous range of records in the area over which you click and drag. As an alternative, you can click the gray selector button for the first record you want to select, hold down the Shift key, and then click the gray selector button of the last record that you want to select. When you do this, Access selects the entire range of records between them. Figure 1.21 shows the Customers table with three records selected. If you want to select a single record when the cursor is within the record, you can simply choose Select from the Find group on the Home tab, and then choose Select. To select all records, choose Select from the Find group on the Home tab, and then choose Select All.
 
 LET ME TRY IT
 
 Deleting Records When you know how to select records, deleting them is quite simple. You just follow these steps:
 
 D e l e t i n g R e co rd s
 
 25
 
 Figure 1.21 The Customers table with three records selected.
 
 1. Select the records you want to delete. 2. Press the Delete key. The dialog box in Figure 1.22 appears, asking whether you’re sure you want to delete the records. 3. Click the Yes button. Access deletes the records. The process of deleting a record is not so simple if you have established referential integrity between the tables in a database and the row that you are attempting to delete has child rows. Chapter 6 covers relationships and referential integrity. For now, you can think about the fact that customers generally have orders associated with them, and those orders have order detail records associated with them. The relationship between the Customers table and the Orders table prohibits the user from deleting customers who have orders. Here’s how you delete a customer who has orders: 1. Select the records you want to delete. 2. Press the Delete key. The dialog box in Figure 1.23 appears, telling you that the records cannot be deleted because the table includes related records. 3. Click OK to close the dialog box.
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 Figure 1.22 Access asks if you want to delete the selected records.
 
 Figure 1.23 Access notifying you that you cannot delete the selected records.
 
 Access provides a referential integrity option with which you can cascade a deletion down to the child table (a table related to a parent table, such as orders related to customers). This means, for example, that if you attempt to delete an order, Access deletes the associated order detail records. If you establish referential integrity with the cascade delete option, the deletion process works like this: 1. Select the records you want to delete. 2. Press the Delete key. The dialog box in Figure 1.24 appears, asking if you’re sure you want to delete the records. 3. Click Yes to complete the deletion process. After you have selected records, they appear in black, and you can copy them, delete them, or modify them as a group. Remember that deleting records is a permanent process. You cannot undo record deletion.
 
 SHOW ME Media 1.4—Selecting and Deleting Records Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 D e l e t i n g R e co rd s
 
 27
 
 Figure 1.24 Access asking if you want to delete the parent row and the associated child records.
 
 Finding and Replacing Records When you are working with records in a large data table, you often need a way to locate specific records quickly. By using the Find feature, you can easily move to specific records within a table. After you have found records, you can also replace the text within them.
 
 LET ME TRY IT
 
 Find a Record That Meets Specific Criteria The Find feature enables you to search in a datasheet for records that meet specific criteria. Here’s how it works: 1. Select the field containing the criteria for which you are searching. 2. Click the Find button in the Find group on the Home tab of the Ribbon. The Find and Replace dialog box appears (see Figure 1.25). 3. Type the criteria in the Find What text box. 4. Use the Look In drop-down list box to designate whether you want to search only the current field or all fields in the table. 5. Use the Match drop-down list box to designate whether you want to match any part of the field you are searching, the whole field you are searching, or the start of the field you are searching. For example, if you type Federal in the Find What text box and you select Whole Field in the Match drop-down list box, you find only entries where Ship Via is set to Federal. If you select Any Part of Field, you find Federal Shipping, Federal Express, United Federal Shipping, and so on. If you select Start of Field, you find Federal Shipping and Federal Express, but you do not find United Federal Shipping.
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 Figure 1.25 The Find tab of the Find and Replace dialog box, which you can use to search for values in a datasheet.
 
 6. Use the Search drop-down list box to designate whether you want to search only up from the current cursor position, only down, or in all directions. 7. Use the Match Case check box to indicate whether you want the search to be case sensitive. 8. Use the Search Fields as Formatted check box to indicate whether you want to find data only based on the display format (for example, 17-Jul-96 for a date). 9. Click the Find Next button to find the next record that meets the designated criteria. 10. To continue searching after you close the dialog box, use the Shift+F4 keystroke combination.
 
 Replacing Data in a Table There may be times when you want to update records that meet specific criteria. You can use the Replace feature to automatically insert new information into the specified fields. Here’s how: 1. Click within the field that contains the criteria you are searching for. 2. Click the Replace button in the Find group on the Home tab of the Ribbon. The Find and Replace dialog box appears. 3. Select the Replace tab (see Figure 1.26). 4. Type the criteria in the Find What text box. 5. Type the new information (the replacement value) in the Replace With text box.
 
 D e l e t i n g R e co rd s
 
 6. Choose values for the Look In drop-down list box, Match drop-down list box, Search drop-down list box, Match Case check box, and Search Fields as Formatted check box, as described in the “Find a Record That Meets Specific Criteria” section of this chapter. 7. Click the Find Next button. Access locates the first record that meets the criteria designated in the Find What text box. 8. Click the Replace button. Access replaces the text for the record and finds the next occurrence of the text in the Find What text box.
 
 Figure 1.26 The Replace tab of the Find and Replace dialog, within which you can replace table data.
 
 9. Repeat step 8 to find all occurrences of the value in the Find What text box and replace them. As an alternative, you can click the Replace All button to replace all occurrences at once. You should use Replace All with quite a bit of caution. Remember that the changes you make are permanent. Although Replace All is a viable option, when you use it you need to make sure you have a recent backup and that you are quite certain of what you are doing. In fact, I usually do a few replaces to make sure that I see what Access is doing before I click Replace All. 10. Click Cancel when you’ve finished.
 
 If you are searching a very large table, Access can find a specific value in a field fastest if the field you are searching on is the primary key or an indexed field. Chapter 5 covers primary keys and indexes.
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 When using either Find or Replace, you can use several wildcard characters. A wildcard character is a character you use in place of an unknown character. Table 1.3 describes the wildcard characters.
 
 Table 1.3 Wildcard Characters You Can Use When Searching Wildcard Character
 
 Description
 
 *
 
 Acts as a placeholder for multiple characters
 
 ?
 
 Acts as a placeholder for a single character
 
 #
 
 Acts as a placeholder for a single number
 
 Filtering Table Data In a table, you can apply filters to fields to limit what records you view. This is very helpful if you want to view just the data associated with a subset of the records. For example, you may want to view just the data associated with Sales Managers.
 
 LET ME TRY IT
 
 Filtering by Selection The Filter by Selection feature allows you to select text and then filter the data in the table to that selected text. To use the Filter by Selection feature, follow these steps: 1. Open a table in Datasheet view. 2. Select the record and field in the table that contain the value on which you want to filter. 3. Click the Filter by Selection button. The data is filtered to only the specified rows. For example, in Figure 1.27, the data shows only orders associated with Jan Kotas.
 
 Removing Filters After you have applied filters, you might want to remove them so that you can once again view all rows or apply a different filter. The process is simple. You just click the Toggle Filter button in the Sort & Filter group on the Home tab of the Ribbon.
 
 Fi l te r i n g Ta b l e D a t a
 
 Figure 1.27 Data filtered to show orders for Jan Kotas.
 
 SHOW ME
 
 Media 1.5—Filtering by Selection Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 TELL ME MORE
 
 Media 1.6—What’s Stored in a Database? Access this audio recording through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
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 Using Access 2010 queries, you can view the data you want when you want to view it.
 
 2
 
 Using Queries to Retrieve the Data You Need In this chapter, you will learn what queries are and why they are important. You’ll learn how to work with queries in both Datasheet view and Design view. We’ll explore the basics of working with queries such as selecting fields, ordering the query result, and using basic criteria. Finally, you’ll see the real power of queries when we work with queries based on data in multiple tables.
 
 What Is a Query and When Should You Use One? A Select query is a stored question about the data stored in a database’s tables. Select queries are the foundation of much of what you do in Access. They underlie most forms and reports, and they enable you to view the data you want, when you want. You use a simple Select query to specify the tables and fields whose data you want to view and to specify the criteria that limits the data the query’s output displays. A Select query is a query of a table or tables that just displays data; the query doesn’t modify data in any way. An example is a query that allows you to view customers who have placed orders in the last month. You can use more advanced Select queries to summarize data, supply the results of calculations, or cross-tabulate data. You can use Action queries to add, edit, or delete data from tables, based on selected criteria, but this chapter covers Select queries. Chapter 7, “Enhancing the Queries That You Build,” covers other types of queries, including Action queries.
 
 Opening a Query When you’re working with an existing query, you need to be able to open it in Datasheet view or in Design view. Datasheet view allows you to view the results of running the query, whereas Design view allows you to view the blueprint, or design of the query.
 
 Opening a Query
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 Open a Query in Datasheet View Here are the steps involved in working with a query in Datasheet view: 1. Select Queries in the list of objects in the Navigation Pane. 2. Click to select the query that you want to run, and then right-click and select Open or double-click the query to run it. The result of the query appears in Datasheet view (see Figure 2.1).
 
 Figure 2.1 The Product Category Sales by Date query in Datasheet view.
 
 A query has an underlying design, which you can think of as the blueprint for the query. This blueprint—not the result of running the query—is what Access stores in the database when you save a query. The text that follows explores the various methods that you can use to view a query in Design view.
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 LET ME TRY IT
 
 Viewing the Design of a Query from the Navigation Pane It is not necessary to first run a query to view its design. You can go directly into Design view of a query from the Database window. Here’s how: 1. Select the query whose design you want to view. 2. Right-click the query, and then select Design. The query appears in Design view (see Figure 2.2).
 
 Figure 2.2 The Product Category Sales by Date query in Design view.
 
 Viewing the Design of a Query While in Datasheet View It is easy to toggle back and forth between Datasheet view and Design view. You accomplish this by using the View tool in the Results group of the Design tab of the
 
 Ad d i n g a n d R e m ov i n g Fi e l d s
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 Ribbon. Notice in Figure 2.3 that the View tool enables you to toggle between the various views available for a query. This makes it easy for you to switch from Design view to Datasheet view and back as needed.
 
 Figure 2.3 The View tool, which enables you to toggle between views.
 
 Adding and Removing Fields When viewing a query in Design view, you might decide to modify the fields that you want to include in the query’s output. In other words, you might want to add fields to or remove fields from the query grid. You would do this if you have an existing query and you realize that it is missing fields, if you have a new query and are adding fields for the first time, or are working with an existing query and realize that you no longer want to include a field in the query.
 
 Adding a Field Between Other Fields There are times when you need to insert a field between two existing fields. To do so, you just drag the field from the field list to the grid and drop it where you want it to appear. The fields already included in the query then move over to the right. For example, your query already contains City and Zip, and you have decided to add the State field and place it between the City and the Zip fields. You would drag the State field from the field list to add it to the query.
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 Adding a Field to the End of the Query Grid Sometimes you want to add a field to the end of the list of existing fields. Fortunately, the process is extremely easy. You just double-click in the field list on the field that you want to add. Access adds the field at the end of the existing field list. This is the technique that I use to add fields to a new query as I build it. I generally double-click each field that I want to add to the query. Access simply adds each field to the query grid in the order that I select each field.
 
 LET ME TRY IT
 
 Adding a Group of Contiguous Fields to the Query Grid It would be very tedious if you had to add each field, one field at a time, to add a contiguous group of fields from the field list to the query grid. Fortunately, Access allows you to add the fields as a group. The process is simple: This is a great technique to use when you are lucky because several of the fields you want to include in the query appear together in the field list: 1. Click the first field that you want to add to the query. 2. Scroll through the field list until you can see the last field that you want to add to the query. 3. Hold down the Shift key as you click the last field that you want to add to the query. 4. Drag the fields as a group to the query grid. The fields are placed on the query grid at the position where you dropped them.
 
 LET ME TRY IT
 
 Adding a Group of Noncontiguous Fields to the Query Grid The process for adding a noncontiguous group of fields from the field list to the query grid is much simpler than adding the fields one at a time. You would add a noncontiguous list of fields when there are several fields that you want to add to the query, but they do not appear together in the field list. Here’s what you do:
 
 M o d i f y i n g t h e S o r t O rd e r o f a Q u e r y
 
 37
 
 1. Click the first field that you want to add. 2. Hold down the Ctrl key as you click each additional field that you want to add. 3. Drag the fields to the query grid by clicking any of the selected fields and dragging them to the query grid. Access adds the selected fields to the query grid at the position at which you drop them.
 
 SHOW ME
 
 Media 2.1—Selecting Fields Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Modifying the Sort Order of a Query You might want to modify the sort order designated by the designer of a query. As described in the following sections, you can sort on a single field or you can sort on multiple fields and you can sort in ascending order or you can sort in descending order. For example, you may want to sort in ascending order by company name in a company table, but in descending order by sales amount in a sales table so that the highest sales amount appears first. An example where you may want to sort on multiple fields is employee last name combined with employee first name.
 
 Sorting on a Single Field Sorting on a single field is a simple process. It works like this: 1. Open the desired query in Design view. 2. Click in the Sort row of the field you want to sort by. 3. Click the drop-down arrow button to display the choices for the sort order (see Figure 2.4). 4. Select the sort order: • Ascending—A to Z or 0 to 9 • Descending—Z to A or 9 to 0 • Not Sorted—No sorting 5. Click the Run button. The data appears in the designated sort order.
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 Figure 2.4 Selecting the sort order of a query.
 
 Sorting on More Than One Field The process for sorting on more than one field is slightly more complicated than the process of sorting on one field. It works like this: 1. Repeat steps 1–4 in the previous section, “Sorting on a Single Field,” for the first field that you want to sort by. 2. Click in the Sort row of the second field that you want to sort by. 3. Click the drop-down arrow button to display the choices for sort order. 4. Select the sort order. 5. Click the Run button.
 
 Moving a Field on the Query Grid Access sorts the data in the query grid from left to right, meaning that if the first name field appears on the query grid before the last name field (see Figure 2.5), the data appears in order by first name and then within first name by last name (see Figure 2.6). Because you probably want the data in order by last name and then by first name, you need to move the Last Name field so that it appears before the First Name field.
 
 M o d i f y i n g t h e S o r t O rd e r o f a Q u e r y
 
 Gray selector bar
 
 Figure 2.5 The query grid with the First Name field before the Last Name field.
 
 Figure 2.6 Datasheet view with the First Name field before the Last Name field.
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 Use these steps to move a field on a query grid: 1. Click the gray selector bar that contains the field name. This selects the entire column. 2. Drag the field to the new location. Access moves the field. (In this case, the Last Name field is moved before the First Name field.) The resulting query grid is shown in Figure 2.7. The resulting output is shown in Figure 2.8.
 
 Figure 2.7 The query grid with the Last Name field before the First Name field.
 
 SHOW ME
 
 Media 2.2—Ordering the Query Result Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Working with Simple Criteria You can limit the records that you see in the result of a query by adding criteria to the query. For example, you might want to see just the customers in California, or you may just want to view the orders with sales greater than $500. You can also
 
 Wo r k i n g w i t h S i m p l e C r i te r i a
 
 41
 
 Figure 2.8 Datasheet view with the Last Name field before the First Name field. view sales that occurred within a specific date range. Using criteria, you can easily accomplish any of these tasks, and many, many more!
 
 LET ME TRY IT
 
 Using an Exact Match Query An exact match query locates data only when there is an exact match with the criteria that you enter. Here’s how you run an exact match query: 1. Open the desired query in Design view. 2. Select the cell on the Criteria row below the field for which you want to add the condition. 3. Type the criteria you want to apply for that field. For example, type Sales Representative in the Job Title field (see Figure 2.9). Click the Run button. The results of this query are shown in Figure 2.10. Although Access is not case sensitive, and you therefore can enter criteria in either upper- or lowercase, the criteria you enter must follow specific rules. These rules vary depending on the type of field the criteria applies to (see Table 2.1).
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 Figure 2.9 Entering simple criteria.
 
 Figure 2.10 Records with Sales Representative in the Job Title field.
 
 Wo r k i n g w i t h S i m p l e C r i te r i a
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 Table 2.1 Rules for Criteria, Based on Type of Field Type of Field
 
 Description
 
 Text
 
 After you type the text, Access puts quotes around the text entered.
 
 Number/Currency
 
 You type the digits, without commas or dollar signs but with decimals, if applicable.
 
 Date/Time
 
 You enter any date or time format.
 
 Counter
 
 You type the digits.
 
 Yes/No
 
 For yes, you type yes or true. For no, you type no or false.
 
 Creating Criteria Based on Multiple Conditions Sometimes you might want to create a query that contains two or more conditions. You would do this, for example, if you want only records in the state of California that had sales within a certain date range to appear in the output. The And condition is used to indicate that both of two conditions must be met for the row to be included in the resulting recordset. You can use the And condition in the same field or on multiple fields.
 
 LET ME TRY IT
 
 Use the And Condition on Multiple Fields By placing criteria for multiple fields on the same line of the query grid, you create an And condition. This means that both conditions must be true for the records to appear in the result. An example of an And condition on two fields is State Field = ‘TX’ And Credit limit >=5000. Here’s how you create an And condition: 1. Open the desired query in Design view. 2. Select the cell on the Criteria row below the field that contains the first condition you want to enter. 3. Type the first criterion you want to enter. For example, you can type Sales Representative as the criterion for Job Title. 4. Select the cell on the Criteria row below the field that contains the second condition you want to apply. 5. Type the second criterion you want to apply. Figure 2.11 shows USA as the criterion for the Country. 6. Click the Run button to run the query. Only rows that meet both conditions appear in the query result (see Figure 2.12).
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 Figure 2.11 The design of a query with criteria for Job Title and Country.
 
 Figure 2.12 The Result Includes All Sales Representatives in the USA.
 
 Wo r k i n g w i t h S i m p l e C r i te r i a
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 Use the And Condition in a Single Field In only a few situations would you use an And condition on the same field. This is because in most situations using the And condition on the same field would yield a recordset with no results. For example, the criteria State = TX and State = CA would yield no results because the state cannot be equal to both values at the same time. On the other hand, HireDate > 7/1/2001 and HireDate < 6/30/2002 would return all employees hired in that date range. Here’s how you would enter this sort of criteria: 1. Open the desired query in Design view. 2. Select the cell on the Criteria row below the field that contains the condition you want to add. 3. Type the first criterion you want to add (for example, HireDate > 7/1/2001). 4. Type the keyword And. 5. Type the second criterion (for example, HireDate < 6/30/2002). 6. Click the Run button. Access runs the query.
 
 You need to make sure when you are adding the criteria to each field that you remain on the same row of the query grid.
 
 LET ME TRY IT
 
 Use Wildcards in a Query You can use wildcards to select records that follow a pattern. However, you can use the wildcard characters only in Text or Date/Time fields. You use the * to substitute for multiple characters, and the ? to substitute for single characters. To practice using wildcards in a query, follow these steps: 1. Open the desired query in Design view. 2. Select the cell on the Criteria row below the field that contains the condition.
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 Figure 2.13 Example that contains Sales* as the Criteria for the Job Title.
 
 3. Type the criteria, using a wildcard in the desired expression. In Figure 2.13, the expression Like Sales* is entered for the Job Title field. This expression returns all rows where the Job Title begins with Sales. 4. Click the Run button. The results of the query are shown in Figure 2.14, and show all the records where the contact title begins with Sales. Table 2.2 provides examples of how to use wildcards. Table 2.2 Examples of Using Wildcards Expression
 
 Results
 
 Sm?th
 
 Finds Smith or Smyth.
 
 L*ng
 
 Finds any record that starts with L and ends in ng.
 
 *th
 
 Finds any record that ends in th (for example, 158th or Garth).
 
 *on*
 
 Finds any record that has on anywhere in the field.
 
 */2000
 
 Finds all dates in 2000.
 
 6/*/2000
 
 Finds all dates in June 2000.
 
 Wo r k i n g w i t h S i m p l e C r i te r i a
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 Figure 2.14 The result of running a query with criteria that contains the wildcard *.
 
 Access displays the word Like in the criteria cell before a wildcard criteria. It is not necessary to type the word Like in the criteria cell before the criteria.
 
 LET ME TRY IT
 
 Use Comparison Operators in a Query Sometimes you want to select records in a table that fall within a range of values. You can use comparison operators (=, , =) to create criteria based on the comparison of the value contained in a field to a value that you specify in your criteria. Each record is evaluated, and only records that meet the condition are included in the recordset. To practice using comparison operators in your queries, follow these steps: 1. Open the desired query in Design view. 2. Select the cell on the Criteria row below the field for which you want to apply the condition. 3. Type a comparison operator and the criteria you want the query to apply (for example, > 100).
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 4. Click the Run button. The result of the query appears in Datasheet view. Table 2.3 gives an example of comparison operators used for a field called Sales. It shows the operators, provides an example of each, and discusses the records that Access would include in the output. You can use the word Not in place of the symbols.
 
 Table 2.3 Comparison Operators Used to Compare Against a Field Called Sales Operator
 
 Indicates
 
 Example
 
 Includes Records Where
 
 >
 
 Greater than
 
 >7500
 
 Sales are greater than 7500
 
 >=
 
 Greater than or equal to
 
 >=7500
 
 Sales are 7500 or more
 
 

 
 Any characters to the right are converted to uppercase.
 
 
, Ctrl+period, Ctrl+ and Ctrl+period take you to the next view; Ctrl+< and Ctrl+comma take you to the previous view.
 
 LET ME TRY IT
 
 Removing a Field from the Query Design Grid To remove a field from the query design grid, follow these steps: 1. Find the field you want to remove. 2. Click the column selector (that is, the small horizontal gray button) immediately above the name of the field. The entire column of the query design grid should become black (see Figure 7.4). 3. Press the Delete key or select Delete from the Edit menu. Access removes the field from the query.
 
 Eve r y t h i n g Yo u N e e d to K n ow A b o u t Q u e r y B a s i c s
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 Figure 7.4 Removing a field from the query design grid.
 
 Inserting a Field After a Query Is Built The process for inserting a field after you have built a query depends on where you want to insert the new field. If you want to insert it after the existing fields, it’s easiest to double-click the name of the field you want to add. If you prefer to insert the new field between two existing fields, it’s best to click and drag the field you want to add and drop it onto the field you want to appear to the right of the inserted field.
 
 LET ME TRY IT
 
 Moving a Field to a Different Location on the Query Design Grid Although the user can move a column while in a query’s Datasheet view, sometimes you want to permanently alter the position of a field in the query output. You can do this as a convenience to the user or, more importantly, to use the query as a foundation for forms and reports. The order of the fields in the query becomes the default order of the fields on any forms and reports you build by using any of the wizards. You can save yourself quite a bit of time by ordering queries effectively. To move a single column, follow these steps: 1. Select a column while in the query’s Design view by clicking its column selector. 2. Click the selected column a second time, and then drag it to a new location on the query design grid.
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 LET ME TRY IT
 
 Move More Than One Column Follow these steps to move more than one column at a time: 1. Drag across the column selectors of the columns you want to move. 2. Click any of the selected columns a second time, and then drag them to a new location on the query design grid.
 
 Moving a column in Datasheet view doesn’t modify the query’s underlying design. If you move a column in Datasheet view, subsequent reordering in Design view isn’t reflected in Datasheet view. In other words, Design view and Datasheet view are no longer synchronized, and you must reorder both manually. This actually serves as an advantage in most cases. As you will learn later in this chapter, if you want to sort by the Country field and then by the CompanyName field, the Country field must appear to the left of the CompanyName field in the design of the query. If you want the CompanyName field to appear to the left of the Country field in the query’s result, you must make that change in Datasheet view. The fact that Access maintains the order of the columns separately in both views allows you to easily accomplish both objectives.
 
 SHOW ME Media 7.2—Moving Fields on the Query Grid Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Saving and Naming Queries To save a query at any time, you can click the Save button on the toolbar. If the query is a new one, Access prompts you to name the query. Access supplies default names for the queries that you create (for example, Query1, Query2). I suggest that you supply a more descriptive name. A query name should begin with qry so that you can easily recognize and identify it as a query. It’s important to understand that when you save a query, you’re saving only the query’s definition, not the actual query result.
 
 O rd e r i n g Q u e r y R e s u l t s
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 Ordering Query Results When you run a new query, the query output appears in no particular order. Generally, however, you want to order query output. You can do this by using the Sort row of the query design grid.
 
 LET ME TRY IT
 
 Order Results of a Query To order the results of a query, follow these steps: 1. In Design view, click within the query design grid in the Sort cell of the column you want to sort by (see Figure 7.5).
 
 Figure 7.5 Changing the order of query results.
 
 2. Use the drop-down combo box to select an ascending or descending sort. Ascending or Descending appears in the sort cell for the field, as appropriate.
 
 Sorting by More Than One Field You might often want to sort query output by more than one field. The columns you want to sort must be placed in order, from left to right, on the query design grid, with the column you want to act as the primary sort on the far left and the
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 secondary, tertiary, and any additional sorts following to the right. If you want the columns to appear in a different order in the query output, you must move them manually in Datasheet view after you run the query.
 
 SHOW ME
 
 Media 7.3—Ordering Query Results Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Refining a Query by Using Criteria So far in this chapter, you have learned how to select the fields you want and how to indicate the sort order for query output. One of the important features of queries is the ability to limit output by using selection criteria. Access allows you to combine criteria by using several operators to specify the criteria for multiple fields. Table 7.1 covers the operators and their meanings.
 
 Table 7.1 Access Operators Operator
 
 Meaning
 
 Example
 
 Result of Example
 
 =
 
 Equal to.
 
 =”Sales”
 
 Finds only records with ”Sales” as the field value.
 
 
=100
 
 Finds all records with values greater than or equal to100 in that field.
 
 
 
 Not equal to.
 
 ”Sales”
 
 Finds all records with values other than Sales in the field.
 
 And
 
 Both conditions must be true.
 
 Created by adding criteria on the same line Finds all records where the conditions in of the query design grid to more than one both fields are true. field
 
 Or
 
 Either condition can be true.
 
 ”CA” or “NY” or “UT”
 
 Finds all records with the value ”CA”, ”NY”, or ”UT” in the field.
 
 R e f i n i n g a Q u e r y by Us i n g C r i te r i a
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 Like
 
 Compares a string expression to a pattern.
 
 Like”Sales*”
 
 Finds all records with the value ”Sales” at the beginning of the field. (The asterisk is a wildcard character.)
 
 Between
 
 Finds a range of values.
 
 Between 5 and 10
 
 Finds all records with the values 5–10 (inclusive) in the field.
 
 In
 
 Same as Or.
 
 In(“CA”,”NY”,”UT”)
 
 Finds all records with the value ”CA”, ”NY”, or ”UT” in the field.
 
 Not
 
 Same as .
 
 Not “Sales”
 
 Finds all records with values other than Sales in the field.
 
 Is Null
 
 Finds nulls
 
 Is Null
 
 Finds all records where no data has been entered in the field.
 
 Is Not
 
 Finds all records that are not null
 
 Is Not Null
 
 Finds all records where data has been entered into the field.
 
 Null
 
 Criteria entered for two fields on a single line of the query design grid are considered an And condition, which means that both conditions need to be true for the record to appear in the query output. Entries made on separate lines of the query design grid are considered an Or condition, which means that either condition can be true for Access to include the record in the query output. Take a look at the example in Figure 7.6; this query would output all records in which the Job Title field begins with either Accounting or Purchasing, regardless of the customer ID.
 
 Figure 7.6 Adding And and Or conditions to a query.
 
 146
 
 Chapter 7
 
 |
 
 E n h a n c i n g t h e Q u e r i e s Th a t Yo u B u i l d
 
 It outputs the records in which the Job Title field begins with Owner only for the customers whose IDs are greater than or equal to 10. Notice that the word Owner is immediately followed by the asterisk. This means that customer would be included in the output. On the other hand, Accounting and Purchasing are both followed by spaces. That means that only entries that begin with Marketing or Owner followed by a space are included in the output.
 
 Working with Dates in Criteria Access gives you significant power for adding date functions and expressions to query criteria. Using these criteria, you can find all records in a certain month, on a specific weekday, or between two dates. Table 7.2 lists the date criteria expressions and examples. The Weekday(Date, [FirstDayOfWeek]) function works based on your locale and how your system defines the first day of the week. Weekday() used without the optional FirstDayOfWeek argument defaults to vbSunday as the first day. A value of 0 defaults FirstDayOfWeek to the system definition. Other values can be set, too. Figure 7.7 illustrates the use of a date function. Notice that DatePart(“q”,[Order Date]) is entered as the expression, and the value 2 is entered for the criterion. Year([Order Date)] is entered as another expression, with the number 2006 as the criterion. Therefore, this query outputs all records in which the order date is in the second quarter of 2006.
 
 Table 7.2 Date Criteria Expressions Expression
 
 Meaning
 
 Example
 
 Result
 
 Date()
 
 Current date
 
 Date()
 
 Records the current date within a field.
 
 Day(Date)
 
 The day of a date
 
 Day ([OrderDate])=1
 
 Records the order date on the first day of the month.
 
 Month(Date)
 
 The month of a date
 
 Month ([OrderDate])=1
 
 Records the order date in January.
 
 Year(Date)
 
 The year of a date
 
 Year
 
 Records the order date in 1991.
 
 ([OrderDate])=1991 Weekday(Date)
 
 Between Date
 
 The weekday of a date
 
 Weekday ([OrderDate])=2
 
 Records the order date on a Monday.
 
 A range of dates
 
 Between #1/1/95#
 
 Finds all records in 1995.
 
 And Date DatePart(Interval, Date)
 
 and #12/31/95#
 
 A specific part of a date
 
 DatePart (“q”,[OrderDate])=2
 
 Finds all records in the second quarter.
 
 Updating Query Results
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 Figure 7.7 Using the DatePart() and Year() functions in a query.
 
 SHOW ME
 
 Media 7.4—Refining a Query with Criteria Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Updating Query Results If you haven’t realized it yet, you can usually update the results of a query. This means that if you modify the data in the query output, Access permanently modifies the data in the tables underlying the query.
 
 LET ME TRY IT
 
 Update Results of a Query To see how this works, follow these steps: 1. Build a query based on the Customers table. 2. Add the ID, Company, Address, City, and State/Province fields to the query design grid and then run the query. 3. Change the address of a particular customer and make a note of the ID of the customer whose address you changed. Make sure you move off the record so that Access writes the change to disk.
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 4. Close the query, open the actual table in Datasheet view, and find the record whose address you modified. The change you made was written to the original table; this is because a query result is a dynamic set of records that maintains a link to the original data. This happens whether you’re on a standalone machine or on a network.
 
 It’s essential that you understand how Access updates query results; otherwise, you might mistakenly update table data without realizing you’ve done so. Updating multitable queries is covered later in this chapter, in the section “Pitfalls of Multitable Queries.”
 
 SHOW ME
 
 Media 7.5—Updating Query Results Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Building Queries Based on Multiple Tables If you have properly normalized your table data, you probably want to bring the data from your tables back together by using queries. Fortunately, you can do this quite easily by using Access queries. The query in Figure 7.8 joins the Customers, Orders, and Order Details tables, pulling fields from each. Notice in the figure that I have selected the ID and Company fields from the Customers table, the Order ID and Order Date fields from the Orders table, and the Unit Price and Quantity fields from the Order Details table. After you run this query, you should see the results shown in Figure 7.9. Notice that you get a record in the query’s result for every record in the Order Details table. In other words, there are 68 records in the Order Details table, and that’s how many records appear in the query output. By creating a multitable query, you can look at data from related tables, along with the data from the Order Details table. Chapter 6, “Relating the Information in Your Database,” discusses how setting up the right type of relationship ensures ease of use in designing system objects. By setting up relationships between tables in a database, Access knows how to properly join them in the queries that you build.
 
 B u i l d i n g Q u e r i e s B a s e d o n M u l t i p l e Ta b l e s
 
 Figure 7.8 A query joining the Customers, Orders, and Order Details tables.
 
 Figure 7.9 The results of querying multiple tables.
 
 To remove a table from a query, you click anywhere on the table in the top half of the query design grid and then press the Delete key. You can add tables to the query at any time by clicking the Show Table button on the toolbar. If you prefer, you can select the Database window and then click and drag tables directly from the Database window to the top half of the query design grid.
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 Pitfalls of Multitable Queries You should be aware of some pitfalls of multitable queries: They involve updating and which records you see in the query output. It’s important to remember that you cannot update certain fields in a multitable query. You cannot update the join fields on the “one” side of a one-to-many relationship (unless you’ve activated the Cascade Update Referential Integrity feature). You also can’t update the join field on the “many” side of a relationship after you’ve updated data on the “one” side. More importantly, which fields you can update, and the consequences of updating them, might surprise you. If you update the fields on the “one” side of a one-to-many relationship, you must be aware of that change’s impact. You’re actually updating that record in the original table on the “one” side of the relationship, and several records on the “many” side of the relationship may be affected. For example, Figure 7.10 shows the result of a query based on the Customers, Orders, and Order Details tables. I have changed Company D to InfoTech Services Group on a specific record of the query output. You might expect this change to affect only that specific order detail item. However, pressing the down-arrow key to move off the record shows that all records associated with Company D are changed (see Figure 7.11). This happens because all the orders for Company D were actually getting their information from one record in the Customers table— the record for ID 12—and that is the record I modified while viewing the query result. The second pitfall of multitable queries has to do with figuring out which records result from a multitable query. So far, you have learned how to build only inner joins. You need to understand that the query output contains only customers who have orders and orders that have order details. This means that not all the customers or orders might be listed. Later in this chapter, you’ll learn how to build queries in which you can list all customers, regardless of whether they have orders. You’ll also learn how to list only the customers that do not have orders.
 
 AutoLookup in Multitable Queries The AutoLookup feature is automatically available in Access. As you fill in key values on the “many” side of a one-to-many relationship in a multitable query, Access automatically looks up the non-key values in the parent table. Most database developers refer to this as enforced referential integrity. A foreign key must first exist on the “one” side of the query to be entered successfully on the “many” side. As you can imagine, you don’t want to be able to add to a database an order for a nonexistent customer.
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 Figure 7.10 Changing a record on the “one” side of a one-to-many relationship.
 
 Figure 7.11 The result of changing a record on the “one” side of a one-to-many relationship.
 
 For example, I have based the query in Figure 7.12 on the Customers and Orders tables. The fields included in the query are CustomerID from the Orders table; Company, Address, and City from the Customers table; and Order ID and Order Date from the Orders table. If you change the CustomerID field associated with an order, Access looks up the Company, Address, and City fields from the Customers table and immediately displays them in the query result.
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 Figure 7.12 Using AutoLookup in a query with multiple tables. Notice in Figure 7.13 how the information for Company F is displayed in the query result. Figure 7.14 shows that the Company and Address fields change automatically when the Customer field is changed to Company C. Don’t be confused by the combo box used to select the customer ID. The presence of the combo box within the query is a result of Access’s Lookup feature. The customer ID associated with a particular order is actually being modified in the query. If you add a new record to the query, Access fills in the customer information as soon as you select the customer ID associated with the order.
 
 Figure 7.13 A query result before another customer ID is selected.
 
 C re a t i n g Ca l c u l a te d Fi e l d s
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 Figure 7.14 The result of an autolookup after the customer ID is changed.
 
 SHOW ME
 
 Media 7.6—AutoLookup in Multitable Queries Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Creating Calculated Fields One of the rules of data normalization is that you shouldn’t include the results of calculations in a database. You can output the results of calculations by building those calculations into queries, and you can display the results of the calculations on forms and reports by making the query the foundation for a form or report. You can also add to forms and reports controls that contain the calculations you want. In certain cases, this can improve performance. The columns of a query result can hold the result of any valid expression. This makes queries extremely powerful. For example, you could enter the following expression: Left([First Name],1) & “.” & Left([Last Name],1) & “.”
 
 This expression would give you the first character of the first name, followed by a period, the first character of the last name, and another period. An even simpler expression would be this one: [Unit Price]*[Quantity]
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 This calculation would simply multiply the Unit Price field by the Quantity field. In both cases, Access would automatically name the resulting expression. For example, Figure 7.15 shows the calculation that results from concatenating the first and last initials. Notice in the figure that Access gives the expression a name (often referred to as an alias). To give the expression a name, such as Initials, you must enter it as follows: Initials:Left([First Name],1) & “.” & Left([Last Name],1) & “.”
 
 The text preceding the colon is the name of the expression—in this case, Initials. If you don’t explicitly give an expression a name, the name defaults to Expr1. You can enter any valid expression in the Field row of the query design grid. Notice that Access automatically surrounds field names that are included in an expression with square brackets, unless the field name has spaces. If the field name includes any spaces, you must enclose the field name in brackets; otherwise, the query won’t run properly. This is just one of the many reasons field and table names shouldn’t contain spaces.
 
 Figure 7.15 The result of using the expression Left([First Left([Last Name],1) & “.” in a query.
 
 Name],1) & “.” &
 
 G e t t i n g H e l p f ro m t h e E x p re s s i o n B u i l d e r
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 Getting Help from the Expression Builder The Expression Builder is a helpful tool for building expressions in queries and in many other situations in Access. To invoke the Expression Builder, you click the Field cell of the query design grid and then click Build on the toolbar. The Expression Builder appears (see Figure 7.16). Notice that the Expression Builder is divided into three columns. The left-hand column shows the objects in the database. After you select an element in the left column, select the elements you want to paste from the middle and right columns.
 
 Figure 7.16 The Expression Builder.
 
 The example in Figure 7.17 shows Functions selected in the left column. Within Functions, both user-defined and built-in functions are listed. Here, the Functions object is expanded with Built-In Functions selected. In the center column, Date/Time is selected. After you select Date/Time, all the built-in date and time functions appear in the right column. If you double-click a particular function—in this case, the DatePart function—Access places the function and its parameters in the text box at the top of the Expression Builder window. Notice that the DatePart function has four parameters: Interval, Date, FirstWeekday, and FirstWeek. If you know what needs to go into each of these parameters, you can simply replace the parameter placeholders with your own values. If you need more information, you can invoke Help on the selected function to learn more about the required parameters. Figure 7.18 shows two parameters filled in: the interval and the name of the
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 field being evaluated. After you click OK, Access places the expression in the Field cell of the query.
 
 Figure 7.17 The Expression Builder with the DatePart function selected and pasted in the expression box.
 
 Figure 7.18 A function pasted by the Expression Builder, with the parameters updated with appropriate values.
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 SHOW ME
 
 Media 7.7—Creating Calculated Fields within the Expression Builder Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Creating and Running Parameter Queries You might not always know the parameters for the query output when you’re designing a query—and your application’s users also might not know the parameters. Parameter queries let you specify specific criteria at runtime so that you don’t have to modify the query each time you want to change the criteria. For example, imagine you have a query, like the one shown in Figure 7.19, for which you want users to specify the date range they want to view each time they run the query. You have entered the following clause as the criterion for the Order Date field: Between [Enter Starting Date] And [Enter Ending Date]
 
 This criterion causes two dialog boxes to appear when the user runs the query. The first one, shown in Figure 7.20, prompts the user with the text in the first set of brackets. Access substitutes the text the user types for the bracketed text. A second dialog box appears, prompting the user for whatever is in the second set of brackets. Access uses the user’s responses as criteria for the query.
 
 Figure 7.19 A Parameter query that prompts for a starting date and an ending date.
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 Figure 7.20 A dialog box that appears when a Parameter query is run.
 
 SHOW ME
 
 Media 7.8—Creating and Running Parameter Queries Access this video file through your registered Web Edition at my.safaribooksonline.com/9780132117128/media.
 
 Creating and Running Action Queries With Action queries, you can easily modify data without writing any code. In fact, using Action queries is often a more efficient method of modifying data than using code. Four types of Action queries are available: Update, Delete, Append, and Make Table. You use Update queries to modify data in a table, Delete queries to remove records from a table, Append queries to add records to an existing table, and Make Table queries to create an entirely new table. The sections that follow explain these query types and their appropriate uses.
 
 Creating and Running Update Queries You use Update queries to modify all records or any records that meet specific criteria. You can use an Update query to modify the data in one field or several fields (or even tables) at one time. For example, you could create a query that increases the salary of everyone in California by 10%. As mentioned previously, using Action queries, including Update queries, is usually more efficient than performing the
 
 C re a t i n g a n d R u n n i n g Ac t i o n Q u e r i e s
 
 same task with Visual Basic for Applications (VBA) code, so you can consider Update queries a respectable way to modify table data.
 
 LET ME TRY IT
 
 Build an Update Query To build an Update query, follow these steps: 1. Select Query Design from the Queries group on the Create tab of the Ribbon. The Show Table dialog box appears. 2. In the Show Table dialog box, select the tables or queries that will participate in the Update query and click Add. Click Close when you’re ready to continue. 3. To let Access know you’re building an Update query, select Update from the Query Type group on the Design tab of the Ribbon. 4. Add to the query fields that either you will use for criteria or Access will update as a result of the query. In Figure 7.21, Ship State/Province is included on the query grid because we will use it as a criterion for the update. Shipping Fee is included because it’s the field that Access will update.
 
 Figure 7.21 An Update query that increases DefaultRate for all clients in California.
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 5. Add any further criteria, if you want. In Figure 7.21, the criterion for Ship State/Province is CA. 6. Add the appropriate Update expression. The example illustrated in Figure 7.21 increases DefaultRate by 10%. 7. Click Run in the Results group on the Design tab of the Ribbon. The message box shown in Figure 7.22 appears. Click Yes to continue. Access updates all records that meet the selected criteria.
 
 Figure 7.22 The confirmation message you see when you run an Update query.
 
 You should name Access Update queries with the prefix qupd. In fact, you should give each type of Action query a prefix indicating what type of query it is. This makes your application easier to maintain, and makes your code more readable, and renders your code self-documenting. Table 7.3 lists all the commonly accepted prefixes for Action queries. Table 7.3 Naming Prefixes for Action Queries Type of Query
 
 Prefix
 
 Example
 
 Update
 
 qupd
 
 qupdDefaultRate
 
 Delete
 
 qdel
 
 qdelOldTimeCards
 
 Append
 
 qapp
 
 qappArchiveTimeCards
 
 Make Table
 
 qmak
 
 qmakTempSales
 
 Access displays each type of Action query in the Navigation Pane with a distinctive icon. Access stores all queries as Structured Query Language (SQL) statements. You can display the SQL for a query by selecting SQL View from the View drop-down list on the toolbar. The SQL behind an Access Update query looks like this: UPDATE tblClients SET tblClients._ DefaultRate = [DefaultRate]*1.1 WHERE (((tblClients.StateProvince)=”CA”));
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 You cannot reverse the actions taken by an Update query or by any Action queries. You must therefore exercise extreme caution when running any Action query.
 
 Creating and Running Delete Queries Rather than just modify table data, Delete queries permanently remove from a table any records that meet specific criteria; they’re often used to remove old records. You might want to use a Delete query to delete all orders from the previous year, for example. It’s important to remember that if you have turned on the Cascade Update Related Fields Referential Integrity setting and the Update query tries to modify a primary key field, Access updates the foreign key of each corresponding record in related tables. If you have not turned on the Cascade Update Related Fields setting and you have enforced referential integrity, the Update query doesn’t allow you to modify the offending records.
 
 LET ME TRY IT
 
 Build a Delete Query To build a Delete query, follow these steps: 1. While in a query’s Design view, select Delete from the Query Type group on the Design tab of the Ribbon. 2. Add to the query grid the criteria you want. The query shown in Figure 7.23 deletes all orders with a Status ID of 3 (closed).
 
 Figure 7.23 A Delete query that is used to delete all time cards entered more than a year ago.
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 3. Click Run in the Results group on the Design tab of the Ribbon. The message box shown in Figure 7.24 appears.
 
 Figure 7.24 The Delete query confirmation message box.
 
 4. Click Yes to permanently remove the records from the table. The SQL behind a Delete query looks like this: DELETE tblTimeCards.DateEntered FROM tblTimeCards WHERE (((tblTimeCards.DateEntered)= (greater than or equal to) operator, 144 ? (question mark), 30
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